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PCM-H64 HARDWARE INSTALLATION GUIDE 

WELCOME! 

Congratulations on your purchase of a SADiE PCM-H64 system; part of a range making up the most 
powerful hard disk editing systems in the world.  These products are the result of over 15 years 
experience in the industry listening to our customers, taking on board their ideas, and providing for 
their needs. Our ethos of close customer contact, has meant that customers not only buy a system but 
also make an investment that will reap dividends as the software expands. We feel confident that you 
will find using this system very enjoyable and hope that our products will be part of your production 
system for many years to come.   

As you take your system out of the box for the first time it is worth spending just a few moments 
reading this document, as it will help you to set up your system effectively and efficiently.  Inside you'll 
find a complete packing list, help with connecting up your system and our troubleshooting guide to 
help overcome any initial problems. 

HARDWARE AND SOFTWARE INSTALLATION 

NOTE: A complete packing list for your new equipment is enclosed. Upon unpacking the 
equipment, please ensure that all the items listed are present. If you think that anything may be 
missing or has arrived in a damaged condition, please contact your supplier immediately 

SADiE PCM-H64 digital audio workstation systems can be provided in TWO basic configurations.:- 

• PCM-H64M which is built into a 5U rack mount chassis unit. The only audio connections 
available are BNCs and Optical connections on the rear of the chassis, for electrical and 
optical MADI respectively. 

• PCM-H64EXP is built into a “double” 8U rack mount chassis – the top 5U section is the PC 
and processor card; the lower 3U expansion chassis contains the audio input and output 
cards, otherwise known as “slithers”. 

 

Other SADiE systems in the H64 family are the PCM-H128M which is a dual card MADI version of the 
PCM-H64M, and the PCM-H128EXP, which are custom-built units including the expansion chassis for 
slithers. 

 

All SADiE H64 systems are provided as "Turnkey" packages, where the required options will be 
provided fitted into a PCM-H64 Chassis unit, with software pre-installed, configured, and ready to go. 
Details of how to install the hardware and software are included here for reference. 

The first "Getting Started" section of this Installation Guide describes how to connect up a Turnkey 
system to its peripherals. The "Technical Reference" section will describe installation and 
specifications of individual cards and items, for reference purposes. 
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GETTING STARTED 

CONNECTING YOUR PCM-H64 

PCM-H64 systems are always supplied as a "turnkey" system including the PC and rack mount 
chassis.  

The top 5U section of all current H64 systems is the same for each variant, and contains the computer 
and SADiE processor card with MADI connections. 

An H64EXP system will have the extra expansion chassis fitted below the PC chassis as in the picture 
below and can be populated with different combinations of input and outputs. 

An H64M – the MADI only system – will only have the top section. 

As well as the PC connections for mouse, keyboard, Displays, SCSI, USB or Firewire interfaces, there 
will be some other connections for the SADiE PCM-H64 on the back of the main chassis unit. 

 

Let's put the bottom section of the box to one side for a moment - this half of the chassis contains  the 
Analog convertors and AES-EBU interfaces, and will be described below. 

In the top half of the box, there will be at least one "TNG3" card, which is the DSP processing card for 
the system.  

In the usual case where the MADI interface option is fitted, as in the diagram above, the reverse of the 
TNG3 card will have 3 x BNC connectors. There's also stereo mini-jack which gives a headphone 
output to monitor channels. 

The other SADiE card inside the top section of the box is the CAT card, which provides RS422 
interfaces, LTC in and out, and Video reference input + loop-through. The will require a "4 legged 
spider" break-out connector - a 25-way D-type on one end, to 4 x flying 9-way D-types and 2 x XLR 
connectors. 

Where a MADI card is fitted, the Optical Input and Output will be fitted either in a free slot or one of 
the holes around the centre of the PC chassis. 
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ANALOG AND AES-EBU CONNECTIONS 

SLITHERS 

Analog, and AES-EBU digital connections, if fitted, are in the bottom section of the H64 chassis unit, 
which is isolated from the computer section, along with its own power supplies.  

There are 12 card-slots; each may be populated with a plug-in I/O card called a "Slither". 

 

Slithers are currently available in a number of varieties:- 

16 x Analog inputs @ up to 192KHz sampling. 

16 x Analog Microphone pre-amps, switchable to line level @ up to 192KHz sampling. 

16 x Analog outputs @ up to 192KHz sampling. 

8 x 2 channel AES-EBU inputs and 8 x 2 channel AES-EBU outputs (i.e. 16 track inputs and outputs 
on one card) @ up to 96KHz on single wire (thus 192KHz uses dual wire). 

Other varieties may be available. 

XLR LOOMS 

It is possible to order the PCM-H64 complete with looms to give you XLR connections for each set of 8 
channels with a 25-way D-type connector at the other end. Thus you would need two of these per 
slither.  Otherwise you may have chosen to connect the Analog and AES/EBU connections by some 
other means, or direct to a patch-bay. Details of the pin-outs for the 25way D-Type connections on the 
slithers are in the Technical Reference section of this manual. 

 

ABOUT H64 

In the SADiE software, in the Help menu, selecting the About H64 item, you will be able to see which 
Slithers are fitted, along with detail about the type of ribbon board and the versions of the various 
hardware components.  
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CHANNEL ASSIGNMENT 

Connector Channels 
A Analogue Output ch 1-8 
B Analogue Output ch 9-16 
C Analogue Output ch 17-24 
D Analogue Output ch 25-32 
E Analogue Output ch 33-40 
F Analogue Output ch 41-48 
G Analogue Output ch 49-56 
H Analogue Output ch 57-64 
I Analogue Input ch 1-8 
J Analogue Input ch 9-16 
K Analogue Input ch 17-24 
L Analogue Input ch 25-32 
M Analogue Input ch 33-40 
N Analogue Input ch 41-48 
O Analogue Input ch 49-56 
P Analogue Input ch 57-64 
Q AES Input/Output ch 1-8 
R AES Input/Output ch 9-16 
S AES Input/Output ch 17-24 
T AES Input/Output ch 25-32 
U AES Input/Output ch 33-40 
V AES Input/Output ch 41-48 
W AES Input/Output ch 49-56 
X AES Input/Output ch 57-64 

 

Where an Expansion chassis is fitted either a Multi Ribbon card, or where applicable the MADI card is 
used for this purpose and the channel assignment is as per the above table.  

However earlier systems may have different types of ribbon card, which may use a different 
assignment. For further information on early H64 systems, refer to the documentation provided with 
the system, or contact support@sadie.com with full details of the system configuration. 
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MADI CONNECTIONS 

If the MADI option is fitted, there will be three BNC connectors on the reverse of the TNG3 card, and 
an optical connector on a lead inside the PC (which will break out into a spare slot or hole in the back 
of the PC.) 

It is possible to have a H64 system with only MADI I/O - in which case, only the top section of the 
chassis unit will be present.  

The BNC connectors are - 

 

Word Clock Out - in the case where the MADI card is fitted but the chassis has no bottom I/O box (or 
no slithers are fitted) the Word clock connection on the MADI card is an output when SADiE is master 
clock, but will switch to being an input when SADiE is set to genlock to an external word clock.  

With slithers fitted, this Word clock connector is only ever an output, and you should use the standard 
Word Clock In connector on the bottom I/O box for locking to an external Word clock signal. 

The optical cable is "handed" and thus can only be connected one way. 
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GETTING STARTED WITH SADIE 6 

You will find a SADiE6 software manual in the package, in the form of a helpfile (accessed from the 
SADiE software itself) and on a CD-ROM as a PDF file. Please refer to Chapter 1 of the software 
manual, entitled "Getting Started", which will introduce you to the following areas of the system: 

• A general introduction to Digital Audio Editing 

• An introduction to SADiE systems 

• SADiE basics (Using Help, User Management, Starting SADiE, The Display, On-screen Help) 

• Tutorial (Connections, Recording, Playing and Arranging the EDL, Saving, Editing, Mixing) 

HELP 

To access it, go to the “Help” menu at the top of the SADiE screen and select “Help on SADiE6”. 

The Help File is set out in the following chapters:  

• Getting Started explains the concepts behind the system and the terminology used and gives 
you a quick guide to getting your system working for you. The Tutorial provides a step-by-step 
guide to editing the audio provided. We recommend that you follow this in order to save time 
later. 

• Recording 

• Using the Playlist 

• Arranging an EDL 

• Editing 

• Mixing  

• File Management 

• Specific Applications contains notes on operations relevant to more specialised areas of work. 
For example: CD pre-mastering; Auto-conforming for video post-production and syncing film 
rushes. 

• Customising SADiE explains the settings you can change to affect the way the system works 
or appears on the screen. 
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SADIE ON THE INTERNET 

WEB SITES AND FAQ PAGES 

The SADiE website is at http://www.sadie.com 

On this site you can find new product information, customer support information, FAQ lists, software 
download areas, contact and supplier information, news, company details, press releases, and details 
of forthcoming trade shows. 

SADIE USER FORUM ON THE INTERNET 

There is an independently run SADiE user forum on the Internet. 

Once you've registered for the SADiE Web board you can view new and old messages online. 
Additionally you can "subscribe" to any or all of the forums on the Web board, and these messages 
will be e-mailed to you directly. 

1. To Register for the SADiE Web board: 

a. Using a web browser go to: http://webbd.nls.net/webboard/wbpx.dll/~SADiE 

b. At this "front-door" you can register as a New User. Once you've applied, you will 
have to wait for a while and the Web board administrators will e-mail you a reply 
including your own password for the site. 

2. Once you have received your password, return to the site and log-on using your e-mail 
address and the password provided. You will be able to access messages in three different 
ways: 

a. Directly on the Web board, where you have the ability to view ALL messages that 
have been posted. The Web board also has search facilities, so you can search to 
see if particular topics have already been discussed 

b. You can choose to receive new messages and reply to them via e-mail. Press the 
"MORE" button, then "Mailing Lists", where you can sign up to receive messages from 
particular conferences via e-mail.  

c. Via a Newsreader. Point the Newsreader at webbd.nls.net and you will be offered the 
sections you have access to. These may include the "Pro-Audio" and "Mastering" 
boards; once you have access to the SADiE Web board you can also access the 
other areas hosted by the Web board. 

The Web board itself has further details of the facilities it offers under "Help". 
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TECHNICAL REFERENCE 

INSTALLING SOFTWARE 

INSTALLING  DRIVER SOFTWARE 

You will need to log on as an administrator in order to install SADiE. 

When you first boot the PC after the SADiE hardware has been inserted in or connected via USB, 
Windows™ will notice the hardware change and offer to “Plug and Play” the hardware and search for 
a driver. 

Windows™ will report "Found new hardware – multimedia controller… Welcome to the Found new 
hardware wizard….". At this point you should press cancel in order to halt the plug and play. 

Windows™ will have installed a generic multi-media controller device at the moment, but installing the 
SADiE5 application software will resolve this and install the correct hardware driver.  

INSTALLING SADIE5 SOFTWARE 

You will have been provided with the installer for SADiE6. This is either on the standard “V5 
SOFTWARE INSTALLATION DISK” with the blue “6” logo, or else it may have been downloaded from 
the SADiE Web site. 

INSTALLING FROM THE CD 

On inserting the V6 SOFTWARE INSTALLATION DISK, if you wait a short while, the “Welcome to 
SADiE Version 6” menu will appear. 

If this doesn’t happen, autorun may have been turned off on your CD drive; the quickest alternative 
way to get to this menu is to: 

Press the Windows™ "Start" button; select "Run" and type z:\autorun (where in this example z: is the 
letter of your CD drive). The “Welcome” menu will now appear. 

To install the SADiE5 software, select your hardware, then Install SADiE v6 Software and follow the 
installer instructions thereafter. 

A SADiE6 icon will appear on your desktop. Double-click this to run the SADiE software. 

DOWNLOADING SOFTWARE FROM THE INTERNET 

The most recent version of SADiE software is available for download on the SADiE World Wide Web 
page. It can be found at http://www.SADiE.com 

On the home page choose Support and then the Downloads link. 

Then download the current version of SADiE 6 Software. 

The download page offers you the SADiE software disks along with other downloads: release notes, 
installation notes, etc. and installers for plug-ins. 

To install the SADiE6 software, you will either be offered the chance to RUN the installer, straight after 
downloading it, or else you will need to navigate to the location on your hard drive that it was 
downloaded to, and double click on the installer file. 

Then follow the instructions on the screen, as above a shortcut will be placed on your desktop – run 
this to run the SADiE application. 

UPDATING THE SOFTWARE 

You may be downloading the SADiE6 software installer in order to update the software to a newer 
version. 

Under normal circumstances, if you are updating to a newer version of software, then running the new 
installer will automatically uninstall the old version first, and then will install the new application files. 
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There are sometimes occasions where this is not possible – if you updating from a very old version or 
perhaps an intermediate beta-test version, then the software itself may tell you that you must manually 
uninstall first. If this happens:- 

• Press the Start button, and choose Control Panel 

• Select Add or Remove Programs 

• Scroll down to find the entry for “SADiE Software”, select it, and press the Remove button 

• Wait until that process has completed, then you can proceed to installing the new version of 
software. 

Note that uninstalling software does not affect any projects you have created, nor will it change any 
settings for the program; it merely removes the application files. 

INSTALLING PLUG-INS 

Software options and plug-ins come in two differing forms – either:- 

a) they are part of the SADiE software and only require to be authorised, or   

b) they are third-party options which require an extra installer. 

INTERNAL OPTIONS / SPW FILES 

The majority of the available options fall into the first category, and you will be supplied with an SPW 
file which may contain one or more authorisations codes. 

With a new system, any SPW files will be in the root directory of the supplied installation CD. On 
starting the SADIE software for the first time, you will be asked to supply this SPW and you should 
navigate to the CD when asked by the software. 

To install SPW files at other times: 

• Run SADIE6 

• From the File menu, select “Install Plug-in Options”  

• Then navigate to the supplied SPW file; the software will check the authorisations and report. 

• Then close SAIDe and re-start the software before you use the plug-ins. 

OTHER PLUG-IN INSTALLERS 

Currently (January 2011) the following options require a separate installer : 

• All Cedar options (De-click96, De-Crackle96, De-Noise96, De-Thump96 and Retouch),  

• Soundfield Surround Zone 

• ProTools5 Interchange 

• OMF Interchange 

With a new system, again, the authorisations for these will be in the root directory of the supplied 
software CD. The menus on the CD can be navigated to run the plug-in installer, and any 
authorisation codes found on the CD will install automatically. 

If you are downloading the plug-in installer, it will come in one of two forms – a ZIP file or an EXE. 

The ProTools5 and OMF Interchange plug-ins are downloaded as zipped sets of files which must be 
extracted first before the installer can be run. 

The others are self-extracting EXE files which will start installing as you double-click to run them. 

If the plug-in installer asks for a password, it will have been supplied to you in a file called PWD??.TXT 
– open this in Notepad, select the string of random characters, right click and copy to paste. Then 
when the installer asks, paste  this string into the dialog box. 

If the installer doesn’t ask for a password, it will have found it automatically (if the PWD??.TXT is in 
the root directory of the disk from which the installer is running, it will find the code). 
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INSTALLATION TROUBLESHOOTING: 

Every PC configuration will be different, so it's difficult to give hard and fast rules about every possible 
situation that may occur. Some guidelines can be offered however. If you are not confident 
troubleshooting the PC installation or are unsure with any of the terms used in this section then you 
should consult someone who is, or contact SADiE customer support. 

You will need to be logged on as an Administrator to install SADiE software and fault find an 
installation.  

It is quite likely that modern operating systems will be able allocate the PC's resources in such a way 
as to avoid conflicts, however conflicts can still occur. The most likely conflict is either one of IRQ or 
"interrupt" or "address" a.k.a. "Port address" a.k.a. "I/O address". 

PCI cards such as the TNG3 and CAT will have the IRQ and I/O address allocated by the operating 
system. The I/O address will be unique, but (in theory) IRQ's can be shared. The TNG3 cards and 
CAT are happy enough sharing an IRQ with each other or another PCI device. However, some other 
PCI devices may not be so happy to do this. Therefore, if in Device Manager, you see another device 
sharing an IRQ with the SADiE audio card, this is not necessarily a problem. However, because a 
shared IRQ is Windows™-legal and the IRQ's are allocated by Windows™, if there is a problem with 
the sharing of IRQ separating the devices can be very difficult. Sometimes a PC will allocate a 
particular IRQ to a particular PCI slot and thus changing the slot may cause the device to "jump" to 
another IRQ.  
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SADIE HARDWARE CONTROL PANELS 

GENERAL 

The SADiE Hardware Controllers consist of two units that have mechanical cross sections similar to 
most common PC keyboards. The larger fader panel has eight assignable touch-sensitive motorised 
faders. The jog unit has one fader and a jog or shuttle wheel in the centre. 

The units can free stand and be arranged to suit the user. A special power supply and RS422 serial 
interface card (the PCI CAT card) are also needed. 

INSTALLATION 

The serial interface card must be installed inside the PC. See the PCI CAT installation sheet later in 
this document for details. 

CABLE CONNECTIONS 

Cable and power supply connection is detailed on the underside of both the jog and fader panels. The 
longer 9-pin cable (15 way D-type on one end and 9-way D-type on the other) must be connected to 
one 9-pin port of the CAT card which is available on the 4-way "spider" as described earlier. 

SOFTWARE INSTALLATION 

To turn on the Hardware Controllers inside the SADiE software: 

• Under the 'View' menu select 'Setup Window' 

• Choose the '9-pin Channels' page on the left side of this window 

• From the drop-down list at the side of the 9-pin port to which the controllers are connected, 
select 'Hardware Controller'.  The lights on the Hardware Controller will change and they will 
now be operational. 

Subsequently, starting SADiE will automatically search for the controllers on that 9-pin channel, and 
initialise them if they are there. If however, the controllers are switched off when SADiE boots, you will 
see an error message. You'll have to power them up, and then initialise them again in the '9-pin Setup' 
page.  

POWER SUPPLY  

This is a fully certificated custom unit that must be supplied by SADiE. A label on its underside 
identifies it. Connect this unit to the local mains via its embedded IEC connector.  Line voltage 
selection is automatic. There are no user adjustments. Allow air to circulate around this power supply 
for cooling purposes.   

USAGE 

There are no on-off power switches on any unit. To switch off (or force a reset) the power supply must 
be disconnected from the mains supply   

When power is applied, the fader and jog panels should display their ROM version number (internal 
control software) on their LED indicators. This display will change when SADiE gains control via the 
serial link 

The SADiE software User Manual and Help file give details throughout of hardware controller 
operation, and also contains a list of the keys and their functions. 
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PCI CAT TIMECODE AND MACHINE CONTROL CARD 

If you have purchased your PCI CAT card as part of a SADiE Turnkey system, then it will have already 
been installed into the system. Otherwise this section will lead you through installing the PCI CAT card 
into your system. This installation should only be carried out by a suitably qualified person. Do not 
remove the PCI CAT card from its protective packaging until indicated by these instructions. Please 
also observe full static safety precautions whilst handling the PCI CAT card, or touching any of the 
internal components of your computer. 

Ensure that the computer is switched off. If your computer has a power switch on the power supply 
unit (near to where the mains lead is connected), this should also be switched to the off position and 
the power cable removed. 

• Remove the computer's lid. 

• Insert the PCI CAT card into a spare PCI slot of the computer motherboard. 

• Connect the PCI CAT card to the TNG3 processor card with the PCI CAT SYNC lead. The 10-
way connector attaches to the PCI CAT card by way of the 10-way box header on the PCI 
CAT card labelled SYNC. Ensure that the wires are at the rear of the connector (this is the end 
nearest to the MIDI connector).  
 
On the SADiE TNG3 card, the two paired cables connect to LK1 and LK2 - it doesn't matter 
which colour connects to which header as these are auto-sensing but you the black cable of 
each pair must be towards the top of the TNG3 card. 

 

• Screw the card into position and replace the computer’s lid. 

• If you are happy that everything has been reconnected correctly, connect the power and start 
the system up. 

• Once Windows has started, Plug and Play will recognise the new CAT card. Be sure to 
Cancel out of this. 

• Then install the SADiE software again; this will load the driver for the Cat card automatically. 
See Installing Software above for details on how to install the SADIE5 software. 
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SLITHER PIN-OUTS 

ANALOGUE 

 

1 Channel 8 HOT 14 Channel 8 COLD 
2 Channel 8 GROUND 15 Channel 7 HOT 
3 Channel 7 COLD  16 Channel 7 GROUND 
4 Channel 6 HOT  17 Channel 6 COLD 
5 Channel 6 GROUND  18 Channel 5 HOT 
6 Channel 5 COLD  19 Channel 5 GROUND 
7 Channel 4 HOT  20 Channel 4 COLD 
8 Channel 4 GROUND 21 Channel 3 HOT 
9 Channel 3 COLD 22 Channel 3 GROUND 
10 Channel 2 HOT 23 Channel 2 COLD 
11 Channel 2 GROUND 24 Channel 1 HOT 
12 Channel 1 COLD  25 Channel 1 GROUND 
13 Not Connected   

(9-16 and higher is the same order) 

To connect an "In" to an "Out" requires a straight pin-to-pin cable. 
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AES/EBU DIGITAL 

 

1 Channel 7+8 OUT HOT 14 Channel 7+8 OUT COLD 
2 Channel 7+8 OUT GROUND 15 Channel 5+6 OUT HOT 
3 Channel 5+6 OUT COLD 16 Channel 5+6 OUT GROUND 
4 Channel 3+4 OUT HOT 17 Channel 3+4 OUT COLD 
5 Channel 3+4 OUT GROUND 18 Channel 1+2 OUT HOT 
6 Channel 1+2 OUT COLD 19 Channel 1+2 OUT GROUND 
7 Channel 7+8 IN HOT 20 Channel 7+8 IN COLD 
8 Channel 7+8 IN GROUND 21 Channel 5+6 IN HOT 
9 Channel 5+6 IN COLD 22 Channel 5+6 IN GROUND 
1
0 

Channel 3+4 IN HOT 23 Channel 3+4 IN COLD 

1
1 

Channel 3+4 IN GROUND 24 Channel 1+2 IN HOT 

1
2 

Channel 1+2 IN COLD 25 Channel 1+2 IN GROUND 

1
3 

Not Connected   

 

To connect an "In" to an "Out" you’ll need a "cross-over" cable. 
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ANALOG LEVEL JUMPERS 

On the Analog Input and Output slithers, the operating level can be chosen, for each Input and Output 
individually if required, by changing the setting of some jumpers. 

With the card components-up, 2 x 25way connectors and face plate to the right, just to the left of the 
connectors, you will see a vertical line of sixteen three-way headers - one for each Input or Output. 

There are three possible ways of connecting these jumpers to change the operating level. This is 
noted in the legend on the slither card 

+24DBU 

 No connection  

+21DBU 

 Jumper to the left  

+18DBU 

 Jumper to the right  

Note that single-ended connection is not advisable for inputs or outputs that are set to +21dBu 
or +24dBu. Factory default is +18dBu. 
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AVI VIDEO OPTION 

Your system may be fitted with the AVI Video option. There is further detail about the software 
component of this option in the main SADiE6 User Manual. 

This consists of: 

• A video input device converting perhaps from composite video to DV format (i.e. the Canopus 
ADVC-100 convertor, however a number of devices are appropriate). This must be attached to 
a IEEE1394 FireWire port in the SADiE PC. SADiE always digitises to DV format AVI files, 
although can playback any AVI for which the PC has the codec - if Windows Media Player can 
play the file, so can SADiE. 

• A customised Matrox Parhelia 128MB graphics card. This replaces the normal display card, 
and provides Dual Head graphics for the computer PLUS a video output for displaying 
SADiE's Video Window on a Full-screen composite video monitor. 

• The software to enable this option (this will already be installed if purchased with a new 
turnkey system). 

The SADiE Video option requires Windows XP Pro, Service Pack 1 or higher, and DirectX version9 (or 
higher). 

AGP APERTURE 

If you’re installing the card yourself, you will probably find that you need to change a BIOS setting for 
“AGP Aperture”. This will depend on what type of BIOS your PC has, but for instance in the Award 
Software, you will find the “AGP Aperture Size” setting under Advanced Chipset Features. You must 
set this to 256MB for a 256MB graphics card, or i.e. 128MB for a 128MB card. This does not apply for 
PCI-Express cards. 

MATROX PARHELIA DRIVERS 

If you are using the “Extended Matrox Parhelia” card, in the SADiE software, you will see a secondary 
“Advanced Video” setup page. It is possible to run the AVI option without this card; however this card 
will give performance enhancements over other cards. 

If you are running the Extended Parhelia, it must be using special drivers, version 1.8.072 or higher, 
which are only available from the SADiE website (and included on the software CD-ROM). 
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CONNECTING THE MATROX PARHELIA 

Connections to the Parhelia card depend on how you are intending to use it.  

The card has two ports at the back of the SADiE chassis; the bottom connector is alwqays the first / 
left-hand computer screen, the top has up to two splitter leads connected to provide the second 
computer screen and the Composite/SVideo output 

The most common setups are: 

Two Computer monitors and one Composite Video Monitor. 

 

Two Computer monitors only (the SADiE video window is viewed on one of the Computer screens). 

 

One Computer monitor and one Composite Video Monitor. 
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As you can see from the pictures above, analog monitors are connected by means of the white D-A 
converters supplied. Digital Computer screens are connected directly to the card for instance :- 

Two Digital Monitors. 

  

 

The Matrox Parhelia will have been set up to your local TV format (PAL/NTSC) as standard. There are 
more details on connection and set up options in the Matrox's own Help file. 

If you are changing the monitor configuration on the Matrox you must always re-start the computer to 
allow all monitors to plug and play correctly. 
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SPECIFICATIONS 

PCM H64 - I/P AND O/P SPECIFICATIONS 

GENERAL 

Figures apply for 32 kHz, 44.1 kHz, and 48 kHz operating frequencies and, in the case of digital I/O, 
their multiples. They do not necessarily apply for minus 0.1%, chase lock, or varispeed rates. 

INPUTS 

DIGITAL INPUT/OUTPUT SLITHER 

Each slither can support eight two-channel digital inputs and outputs. Separate reference inputs are 
available on the H64 chassis, for clock synchronisation purposes. 

AES INPUTS 

D-type 25 female connectors: transformer balanced and isolated. 

• Accept levels between 500mV and 10V peak-to-peak. 

• Accept digital protocols to S/PDIF (consumer, IEC 958) or AES (professional AES3-1992) 
format, 32 – 96 kHz +10% 

• Impedance: 110ohms 

• No equalisation fitted. 

DIGITAL REFERENCE INPUT (GEN_LOCK) 

XLR female connector: transformer balanced and isolated. 

• Accepts levels between 500mV and 10V peak-to-peak. 

• Impedance: 100 ohms ± 10% 

• No equalisation fitted. 

ANALOGUE INPUT SLITHER 

Each analogue input slither card supports 16 channels of analogue input. These signals appear on the 
D-type 25way connectors on the rear of the H64 unit. Breakout cables can be used to break to signals 
out to XLR connectors. These signals are electrically balanced. 

• Nominal Level for peak digital audio (sine wave): 

Balanced, jumper selectable for +18dBu, +21dBu and +24dBu 

• Conversion:  

24-bit 64-times over-sampling delta sigma converters, one per channel, simultaneous 
conversion, up to 192kHz sample rate. 

• Input impedance:   > 54K ohms, balanced    

• Frequency response:   1Hz – 23.4kHz (+0dB / -0.5dB, 48k sample rate, +18dBu I/P), AC 
coupled 

• THD+N relative:  -103dB  (1kHz, +18dBu I/P, 22Hz/22kHz filters, RMS Response, No  

    weighting, 48k sample) 

• CMRR:   63dB  (1kHz, +17dBu I/P, 48k sample) 

• Crosstalk:  -98dB  (1kHz, Channels 1-2) 

• SNR:   -109dbFS (1kHz, +18dBu, 22kHz BW) 
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Technical Specification of Mic Slither Inputs V1.1 

Inputs:                  16 Balanced via XLR-3 connections from D-25's 
   software selectable between mic and line. 

Input Impedance:        5 Kohms differential 

Maximum Input Level:     +18 dBu (LINE Mode) 

                          -19 dBu   (MIC Mode: minimum gain=10dB, 50ohm source) 

Gain Range:              10dB to 65dB in 1dB steps 

Frequency Response:      12Hz to 21kHz +/- 0.1dB (44.1kHz sampling rate) 

12Hz to 42kHz +/- 0.1dB (96kHz sampling rate) 

Channel to channel 
Variation (THD+N)        < 1dB 

Signal to Noise:              -107 dB 

MIC MODE 

Equivalent Input Noise:  -128 dBu  (22Hz-22kHz, 65dB gain, 150Ω source, no-weighting) 

Distortion and Noise:    -91 dBu  (22Hz-22kHz, 30dB gain, max I/P level, no-weighting) 

Phantom Power:   +48V +/- 2V : switchable for each MIC input independently 

Crosstalk (worst):          -56 dB   (1kHz, +8dBu into one channel, other channel measured with 65dB 
gain applied) 

LINE MODE 

Distortion and Noise:    -82 dBu THD+N absolute @ 1kHz (max I/P Level (LINE), 22Hz-22kHz, no-
weighting) 

CMRR              62 dB    (1kHz, LINE mode worst case) 

Crosstalk         -105 dB (1kHz, LINE mode) 

 

OUTPUTS 

AES OUTPUTS 

D-type female connectors, transformer balanced and isolated. 

• Generates digital protocols to S/PDIF (consumer, IEC 958) or AES (professional AES3-1992) 
format, 32 – 96 kHz +10%, depending on software selection. 

• Output level: 10V p-p (5V p-p when terminated in 110W) 

• Source impedance: 110 ohms +/- 10% 

• Symbol jitter  < 7ns p-p RMS 
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ANALOGUE OUTPUT SLITHER 

Each analogue output slither card supports 16 channels of analogue input. These signals appear on 
the D-type 25way connectors on the rear of the H64 unit. Breakout cables can be used to break to 
signals out to XLR connectors. These signals are electrically balanced. If the output signal is 
terminated into a single ended output, then +6dB is added to the signal.  

• Level for peak digital audio (sine wave):  

Jumper selectable on the slither for +18dBu, +21dBu and +24dBu 

• Conversion: 24-bit 64 times over-sampling delta sigma converters, one per channel, 
simultaneous conversion, up to 192kHz sample rate. 

• Output impedance:  50 ohms, balanced, dc coupled 

• Frequency response:  6Hz – 24kHz  (+/- 0.5dB, 48k sample rate, +18dBu I/P) 

• THD+N relative:  -100dB  (1kHz, +18dBu, 22Hz/22kHz filters, RMS Response, No 
weighting, 48k sample) 

• Crosstalk:  -105dB (1kHz, Channels 1-2) 

• SNR:   -105dbFS (1kHz, +18dBu, 22kHz BW) 

• Dynamic Range:  128dB  (1kHz, +18dBu, 22kHz BW) 

E-E 

Performance when operating E-E (Electronics to Electronics, i.e. input is processed via input 
electronics then via output electronics without intervening recording or audio processing): 

DIGITAL INPUT TO OUTPUT 

• Sample rate out is locked to sample rate in. 

• Output protocol is independent of input protocol, i.e. can convert AES to S/PDIF or vice versa. 

• User bits are not passed through system. 

• Output data equals input data, i.e. signal is unchanged (16 - 24 bit signals only, dithering off, 
with both input and output selected to match the test data). 

ANALOGUE PERFORMANCE, INPUT TO OUTPUT 

•  Frequency response: 20 Hz – 20 kHz, +0.5 dB, AC coupled. 

• Total distortion and noise  with 1 kHz applied at peak level: better than 90 dB below peak. 

EMPHASIS 

PCM Series 5 supports emphasis only in channel status sub-code. 

RECORDING METHOD 

No data compression is used. Recorded data is replayed unchanged if no processing is selected in 
software. 
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POWER REQUIREMENTS (TURNKEY PCM SERIES 6 UNIT) 

• 90V - 230V or   +/- 10% , AC 50-60 Hz.  

• IEC line connector 

• Steady-state power requirement  < 300 W 

• Fuse: 5 Amps (T)  

COMPLIANCE 

Case is CE marked:  

Conforms to the following standards: 

• EN50081-1 (EN55022); 1995 

• EN50082-1 (EC 801-2,3,4); 1992  

Following the provisions of the Low Voltage and EMC Council Directives:  

• 73/23/EEC 

• 89/336/EEC 

MECHANICAL 

• SADiE turnkey: 19" rack mounting chassis. 4U. 

Max dimensions: 485mm wide x 550mm deep x 180mm high. 

Mass < 20 kg 

or 

• SADiE turnkey: 19" rack mounting chassis. 7U. 

Max dimensions: 485mm wide x 550mm deep x 315mm high. 

Mass < 20 kg 
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CONFORMITY STATEMENTS 

EUROPEAN COMMUNITY - CE 

SADiE declares that its products conform to the following standards: 

• EN50081-1 (EN55022); 1995 

• EN50082-1 (EC 801-2,3,4); 1992  

Following the provisions of the Low Voltage and EMC Council Directives:  

• 73/23/EEC 

• 89/336/EEC 

UNITED STATES OF AMERICA - FCC 

SADiE declares that its products conform to the Part 15 of FCC rules concerning generation of and 
susceptibility to electromagnetic interference provided it is used unmodified and in accordance with 
manufacturers instructions 

 


